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Technical Note

How to Setup MVI56-PDPMV1

Using Add-On Instruction and CIPconnect™

Introduction

The goal of this technical note is to allow any user to successfully achieve the complete
MVI56-PDPMV1 setup.

When the user will have followed the procedure, the module will be up and running.
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Architecture

The following material was used to prepare this technical note:
1. Rockwell Automation:
o 1756-A4
o 1756-PA72
e 1756-1756-L61 V16
e 1756-ENBT
2. ProSoft Technology:
e MVI56-PDPMV1 V1.28

The following software were used to prepare this technical note:
1. Rockwell Automation:
e RSLogix V16
¢ RSLinx Classic V2.54
2. ProSoft Technology:
e ProSoft Configuration Builder V2.1.1.9

Architecture drawing:

AB

.. Allen-Bradiey
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Procedure

Below is the step by step procedure to establish communication between a ControlLogix and a

PROFIBUS network:

A. Setup of the MVI56-PDPMV1

A.1.

Launch RSLogix 5000 by d

The following windows will appear:

£ RSLogix 5000
File Edit View Search Logic Communicatons Tools Window Help

Step 1:

Using RSLogix 5000 V16

ouble clicking on the icon on your desktop or in the start menu:

=1o ]

EEEEREEEE]

ol &5l Bl W] &la

0., = RUN
I 0K,
I BAT
M 1/0

No Controller

Mo Forces
o Edits
Fedundancy:

b
=S
1

Create Qutput Energize instruction

_,_q') - ‘ Path: [BB_ETHIP-11182156.170.180\B ackplane0 -] ||

o il selelololel
Ll_bl\ Favorites £ Alarms f{ Bit & Timer/Counter X Input/Output

m
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A.1.1. Creating new project

Select File>New... in the RSLogix 5000 menu:
f RSLogix 5000

File Edit View Search Logic Communications Tools Window Help

S Mew ctrl+n |
= Open... Ctrl+0
Close F'ath:E

=S
Y % Favo
Mew Component 4

Select the correct settings for your application.
For the example, it will be a 1756-L61 processor in version 16 placed in slot 0 of a 4 slots

chassis:
New Controller x|
Yendor: Allen-Bradley
Type: 1756-L61 ControlLogis5561 Controller
Revision: Cancel

[ Redundancy Enabled Help |
M ame: IM‘JIEEF‘D P I

Dezcription: ;I

[~

Chassiz Type: I1?58-.-‘1'«4 4-Slat ControlLogix Chassis "Il

Slat; Satety Partner Slot:
Create Ir: IE:HHSLDgiH A000MProjects Browse... |
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The following window appears:

& RSLogix 5000 - MVIS6PDPMV1 [1756-161]

=[]
File Edit View Search Logic Communications Tools Window Help
| al=l8l 8| HlEle] oo o] #lslel [E 2= alal
Offfine 7. T RUN E‘ Path: [<nane> jﬂ|
Mo Forces k. I7 ok ¥
[ - Y A Sl Hele o] o] o] A
Fedundancy 5.4 ll A| v Favorites £ AddOn_f_Alarms g _BR_A_Tmer/Counter AT

[SRe=] Controller MVISEPDPMY 1
A Contraller Tags

- Controller Fault Handler
i...[23 Power-Up Handler
145 Tasks
E\% MainTask
CE MainProgram
“.[13 Unscheduled Programs | Phases
[E1-£5] Motion Groups
¢ L3 Ungrouped Axes
i--[271 Add-On Instructions
E -£5] Data Types
¢ g User Defined
£ strings
[ Add-on-Defined
7L, Predefined
Eﬂ Module-Defined
(3 Trends
E1-£5] 1/O Configuration
-8 1756 Backplane, 1756-A4
L. [0] 1756161 MVISSPOPMY 1

Add Branch
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A.1.2,

Inserting MVI56-PDPMV1 in I/0 configuration

In the I/O configuration tree branch, right click on 1756 Backplane, 1756-Ax and select

New Module...:

¢ @-Lg Predefined

: L Module-Defined
I:I Trends

EIB 1O Configuration

=¥ -} 1756 Backplane, 175620
L. 0] 1?564.61M'u| Bl Mew Module...

R Paste Ctrl+

Make sure you see the By Category tab, browse Other category and select 1756-MODULE:

[N select Module

x|

Module |Descri ion

|\|’endor |

=8 Analog

&= 1756-MODULE Generic 1756 Module

- Spedialty

1 3

Allen-Bradley

| Add Favorite |

IB_-,l Cateqory I By Yendor I Favarites I
covd ||
Ve

Enter a name for the module, select the Data — INT comm. Format, select the slot where the
CPU is installed and configure the connection parameters as explained in the user manual.
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Mew Module =l

Type: 1786-MODULE Generic 1756 Module
Parent. Local — Connection Parameters

Bzzembly )

Instance: Size:
Mame: IF'E'F""""\'""I I Input: I-| |25':' ﬁ [1E-bit)
Dezcnption: ;I Output; I2 |243 ﬁ [16-bit])

ﬂ Configuration: |4 IEI ::|| [B-bnit]

Comm Format: f Data - INT j Sitatus Input: I I

Slat; 1 =

Status Dutput: I

v Open Moduls Properties

Cahcel | Help
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Select the RPI required for your application (for the example, we will work with 5ms) and click OK:
x

Gereral Connection |h-1|:u:|ule Infu:ul Backplanel

Requested Packet Interval [RP): [0.2 - 7500 mz]

[ Inhibit Module

[ Major Fault On Controller IF Connection Fails 'hils in Fun Made

M odule Fault

Status: Dffline Cancel Apply Help
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A.1.3. Inserting the MVI56-PDPMV1 program

In the tree view, expand the MainProgram task and select the MainRoutine routine:

& RSLogix 5000 - MVIS6PDPMV1 [1756-161]*

File Edit View Search Logic Communications Tools

al=E| 8| %22 =] |

i ]
Offline fl. 7 BUN A
Mo Forces b :: oK q}

Mo Edits = BAT
10
Redundancy b0 i |

(=15 Controller MVISSPDPMY 1
i@ Controller Tags

{23 Controller Fault Handler
—[7 Power-Up Handler
E-E5 Tasks

=8 MainTask

EH:E MainProgram

| Program Tags
------ B e
-[13 Unscheduled Programs / Phases
Ela Motion Groups

R 5| Ungrouped Axes

Double click on the MainRoutine routine, the routine opens:
[El MainProgram - MainRoutine* =10l I

@@ @ m
|»

(End)

MainRoutine* [ j
o N | | L
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Right click in the line (in the blue part in the screenshot below):

[El MainProgram - MainRoutine™®

EEEEE]

&  CutRung Cirl4%
Copy Rung Ctrl+C
(Eng) 2 Paste Ctrl+v i

Delete Rung Del
Add Rung Ctrl+R
Edit Rung Enter
Edit Rung Comment Ctrl+D

[ portrung.. |
Export Rung...

Browse your computer to find the add-on instruction:

& Import Rung

Mame =

~| e EBEerE-

~| Date created

|| PS56PDPMY1_FLEX.L5X

File name:

Files of type:

Bl rsssPopmyvl LEGACY.LSX

|PS56PDPMVI_LEGACY L5X [

[RSLogx 5000 XML Files (*.L5X) [~

Author: Jerome Prat
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The following window let you select tag creation, simply click OK:

Import Configuration

Tags | Data Types | Add-On Instructions |

I Mame & | Aliaz For Data Type Dezcription Operation

| & ﬂ Local1:l - AB:7EE_MOD Lze Exizting

5 E Local1:0 AB1FRE_MOD Lse Existing
E W BEFD PR FPOPMY1_Mod Create Mew
E PSEERDPRYT PSEEPDPMYT Create Mew

RSLogix 5000 will the process the import of the Add-On Instruction:

Creating routing; Prescan

The code needed to allow the MVI56-PDPMV1 to operate will then appear in the MainRoutine:

MVISE-PDPMV1 Add-On
(Legacy)
——— PSSEPDPMY1_LEGACY

MVISE-PDPMV1 Add-On (Legacy)

PS56PDPMWV_LEGACY PS58PDPMWA |:|

Connection_Input Local1:.Data
Connection_Cutput Local1:0.Data
MWISEPDPMYWA MWVISEPDPMY 1
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A.1.4. Adapting the ladder logic to the application

Delete the empty rung (0) by selecting the rung and pressing the <Del> key or right click on
the rung and click on Delete Rung:

¥ CutRung Cirl4%
Copy Rung Ctrl+C

E, Paste Cirl+y

| Delete Rung Del
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A.1.5. Verifying and downloading ladder logic

Verify the ladder logic by clicking the Verify Controller button:
& RSLogix 5000 - MVIS6PDPMV1 [1756-L61]* - [MainProgram - MainRoutine*]

B Fle Edit View Search Logic Communications Tools Window Help

BlSEl & %3 oo

-l fl%lel = ME @&l

OFfhine . T RUM
TR v Lok

|
I_d‘tlJ

Path:

£ NIOKE: Verify Controller

il

The Controller Verification should result in 0 errors and 0 warnings (Error window can be tiled

at the bottom of the screen or windowed):

Verifying Controller. ..

Verifyving routine Logic of Instruction PSS6ePDPMV1_FLEX
Yerifwving routine Prescan of Instruction PSS56ePDPMYV1_FLEX
Yerifving routine MainFoutine of Program MainProgram

0 warning(=)

Complete — 0 error(=s).

4|+ |\ Errors 4 Search Resute A Watch || 4|

b

Save the ladder logic:

f& RSLogix 5000 - MVISG6PDPMV1 [1756-L61]* - [MainProgram -

B | Fle Edit View Search Logic Communicatons Tools Window

-3 New... cul+N
== open... cul+0 E
E Close !
%|H Save Cirl+5 |J
a Save As... i

Select the Communications>Who active menu like below:

§& RSLogix 5000 - MVIS6PDPMVL [1756-L61]* - [MainProgram

E File Edit view Search Logic | Communications Tools Windo

; 24 : Who Active | —
2 (2|E| & 3w Y
QI_I_I _I _I_I_I Select Recent Path...  f=
Offline ﬂv ] RLIM ..
Mo Farces b PEET Go Online |
Mo E dits 2 - Upload... s
170 Download
Redundamcy L5 \
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Browse to the ControlLogix CPU like below, set the path as default to the project by clicking

Set Project Path (optional) and click Download:

f% Who Active =101 |
¥ tutohrowse Refresh I
== Workstation, JEROMEE5500 | GoOnine |

-,5'15 Linx Gateways, Ethernet
El-&5 AB_ETHIP-1, Ethernet
; 192, 158.170. 190,
192,158,170, 191,
192, 158, 170. 194,
192, 158, 170. 195,

1756-EMBT/A, 1756-EMET/A

1756-EMBT/A, 1756-EMET/A

01, 1756 module, MVISE Pro
03, 1756-ENET/A

<

1769-L32E Ethernet Port, 1769-L32E Ethernet Pc

1769-L35E Ethernet Port, 1769-L35E Ethernet Pc

Dpdate Firmware. .

Path: AB_ETHIP-1%192.168.170.19548 ackplanet0
Fath in Project: <nonex

[Elear Project Path |

&

If no driver is installed, please refer to Appendix C -

The following message appears, click Download:

Dowirlaad offline project tWISEPD P ta the cantraller.

l : Connected Caontroller:
Mame: PO PR
Type: 1756-LE1/BE ControlLogi=B561 Controller
Path: AB_ETHIP-14192.168.170.195%B ackplans'0
Serial Mumber:  004027C3
S ecurity: Mo Protection

& The controller is in Remote Bun mode. The mode will be changed to
Fiemate Progran prior to download.

[’l\; DAMGER: Unexpected hazardaus motion of machinery may ocour.

Some devices maintain independent configuration settings that are
not lnaded to the device during the download of the controller.

Yerify these devices [dives, network devices, 3rd party products)

have been properly loaded before placing the controller into mwin mode.

Failure to load proper configuration could result in misaligned data and
unexpected equipment operatioh.

Dawnload Cancel

Help

Configuring RSLinx - p.40.

]
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RSLogix downloads the ladder logic to the ControlLoigx CPU:

Linking &ll Routines. ..

Cancel

Once download is finished, the following message appears, click Yes to run the CPU.

RSLogix 5000 |

I k Done downloading. Change controller mode back to Remote Run?

Yes Mo |

The CPU should now be up and running and status be like below:

& RSLogix 5000 - MVISG6PDPMV1 [1756-L61]* - [Main!
E File Edit view Search Logic Communications Tool

8l & &[] o]

Rem Run A% © FunMade
Mo Farces 3 ¥ Controller 0K @
. = [T Battery 0K
Mo Edits = F L0 oK
Bedundarzy 8.8 ll
Author: Jerome Prat Page 16 of 44
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A.2. Step 2: Using ProSoft Configuration Builder

Launch ProSoft Configuration Builder by double clicking on the icon on your desktop or in the

start menu:

]

ProSoft
Configuration
Builder

The following window appears:
:'ﬂ_untitled - ProSoft Configuration Builder
File Edit View Project Tools Help

=15 ]

{1 Default Project I Mame

| Information

=] Cﬁl Default Location 1 Default Module
o 4 Default Module Unknown Product Line -1

Last Change:
Last Download:

4]

Flease Select Module Type

[
# Module Information

# Last Change: Never
# Last Download: Never
# application Rev:

# 05 Rev:

# Loader Rev:

# MAC Address:

# Module Configuration

[Module]
Module Type :

Ready

# ConfigeEdit Version: 2.1.0 Build 14

Module name : Default module

|Updating data from new database NUM 4

Author: Jerome Prat
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Page 17 of 44
TN2009-01D-A4-2.0




Technical Note

0:2:0 .
PrOSOﬂ How to Setup MVI56-PDPMV1

TECHNOLOG Y Using Add-On Instruction and CIPconnect™

A.2.1. General module configuration
Double dick on the “Default module” in the “explorer like" tree:

(] Untitled - ProSoft Configuration Builder

File Edit View Project Tools Help

EH:| Default Project | Mame
=l Default Location ' Default Module
S Unknown Product Line -1
Last Change:
Last Download:

The following window appears; select the MVI56-PDPMV1 in the list by following the numbers:

Author: Jerome Prat Page 18 of 44
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Choose Module Type

X

= all
 PLX4K

 PL¥SK
" PLXGK

Product Line Filter
o
= MVI 69

PTG 56 & MVI 71

i MVI 46 i MVI 94

STEFP 1: Select Module Type

Search Module Type

Module Definition:

[EC-370-5-101 SERVER COMMUNICATION
MODULE

MVI56-1015

MWVISE-FLM
MVIsGe-GEC
MWVISG-HART
MVISE-KOS
MVISE-MCMR
MVISE-MDA4
MVISE-MDALG
MWVISG-MMET
MWVISG-MMETC
MWVISG-MMNETCR
MVISE-MMETR.
MVISE-N2

MVIsG6-PDFPS
MVISG-533964R
MVISE-WA-FWE

2

| Action Required

UnCheck if Mot Used
UnCheck if Mot Used

"'--..____3

Cancel_|

Author: Jerome Prat
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The following window will appear:
] Untitled - ProSoft Configuration Builder
File Edit View Project Tools Help

=] [:l Default Project | MName ‘ Status ‘ Information
[=1-# Default Location 9 MVISG-PDPMVL Check Ports for errors MVIS6-PDPMVL
=8} MIVIS6-PDPIMVL MVIS6 POMS 0.30
Comment Values OK
PDPM Values OK
&  PROFEUS DP Check for errors This Section contains Profibus Configuration Information
Last Change: Never
Last Download: Never

If you expand the MVI56-PDPMV1 module in the “explorer like” window and select MVI56-
PDPMV1>MVI PDPM-V1>MVI Profibus Master DPV1, you can see different branches:

(] Untitled - ProSoft Configuration Builder

File Edit View Project Toolz Help

=7 Default Project
=-{Za] Default Location
- MVISE-PDPMV1
El-g%, Comment
: - [B Module Comment
=l g82, MVI PDPM-V1

[ 311 Profibus Master DPV1

.18 PROFIBUS DP

The default MVI Profibus Master DPV1 settings are correct for our application as we will
use the Legacy mode, we will not change it.
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A.2.2. PROFIBUS configuration

Select and double click on MVI56-PDPMV1>PROFIBUS DP, in the main window:

(] Untitled - ProSoft Configuration Builder

File Edit View Project Tools Help

-7 Default Project
EH:EI Default Location
- MVISE-PDPMVL
g%, Comment
...[B Module Comment
=l g% MVIPDPM-V1
- -[B MvIProfibus Master DPV1
L PR OFIBUS DF

Click on “Configure PROFIBUS" button:
x|

—PROFIBUS Master - Module Communications
|Prufib|.|5 Editor : Not started

Select Port: ICorn 1 'I

Firmware Update |

TestCDnnectiDnl GIP. Path Edit | Cancel Update |

— PROFIBUS Setup and Monitor
[ Prohibit Master Control

I Configure PROFIBUS I

Zancel Mantor/Madify |

Checksums

PROFIBUS: I
Module: I

Calculate |

— Processor Network Memory Map

Shaw Memory Map |

Export Master Config

Author: Jerome Prat
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The ProSoft configuration Builder for PROFIBUS window now opens (you can maximize the
Bus Configuration 1 window if you prefer):

__"s' ProSoft Configuration Builder for PROFIBUS - MVIS6-PDPMVL
Project View PROFIBUS Onlne Option Tools Windows Help

Hisb|&s s
.. \ProsofthGSD << f Bus Configuration 1
=% PROFIBUS DP
§ PROFIBUS Master 1] Prsoft

Master

| |

Bugz addr... | Type | Mame | ‘Wendor | Comment ill

Mazter ProSoft PraSaft Technology

A m e L =D

.

Browse the PROFIBUS DP tree branch to select your PROFIBUS slaves.
If you cannot find your slave in the list please refer to
Appendix A - Importing GSD file - p.35.

Drag & Drop slaves to the PROFIBUS network:
f ProSoft Configuration Builder for PROFIBUS - MVIS6-PDPMV1 - [Bus Configuration 1]

mPruject View PROFIBUS Online Option Tools Windows Help

H &R &9

L AProzafthGSD {4
=% PROFIBLS DP

-3 140
=110 Gateway
Q Schheider Electic GrbH
El{:l PraoLins u:umrn atewa_l,ls Inu:# ; .ﬂ - ,-,..
m ProLing Profibu. Slave
- ProSoft Technalogy, Inc.
A-27 Drives
f-{7] Contraller
i-{7] General
PROFIBUS Master

[1] PraSoft

LN i rn |
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The slave now appears in the PROFIBUS layer:

2’ ProSoft Configuration Builder for PROFIBUS - MVIS6-PDPMV1 - [Bus Configuration 1] - EI|5|
ﬂ Project View PROFIBUS Online Option Tools Windows Help - E‘lﬂ
CIEI =Y
..AProsoft\GSD <<
(1] ProSoft
=% PROFIBUS DP
s
-0 Gateway
¢ @20 Schneider Electiic GmbH
: ProLins Comm Gateways Inc.
“ ProLinx Profibus Slave
PraSalt Technalogy, Inc. “
23 Drives
2 Contraller
[ General
E-f PROFIBUS Master
Slave: [3] ProLing Profibus Slave Device path:  PROFIBUS DP\GatewaysProLinx Comm Gateways Inc.%\ProLinz Profibus 5
Slat. | CFG data | Order number/ designation | Input address | Output address |
]
1
2
3
4
5
E
7
]
3
10
"
12
13
v

NOTE: Default slave address for the first slave is 3, if you need to change it, please refer to
Appendix B - Changing PROFIBUS slave address — p.38

Expand the Slave in the tree view; this shows you the list of supported slots for the slave:

;’f ProSoft Configuration Builder for PROFIBUS - MVIS6-PDPMV1 - [Bus Con

ﬂProject View PROFIBUS Online Option Tools Windows Help

HEh s
- AProsoftyGSD <«
(1] ProSoft
El‘pt’x PROFIBUS DP =
{:l 10
B Gateway

&0 Schneider Electic GmbH
EI{:I ProLine Comm Gateveays Inc.
E|‘i PralLit« Profibu
----- @ Empty Slot

[ 1 word Input

M 2words Input

@ 3'Words Input

M 4words Input

@ 5Words Input

[ &words Input

M 7 words Input

[ 2%words Input

M 9%ords Input

B 10 wfards lamnt

(3] ProLims

Author: Jerome Prat
Date: Feb-09

Page 23 of 44
TN2009-01D-A4-2.0




ProSoft

Technical Note
How to Setup MVI56-PDPMV1

TECHNOLOGY

Using Add-On Instruction and CIPconnect'”

Drag & Drop desired slots in the slots window:
L’f Pro5oft Configuration Builder for PROFIBUS - MVIS6&-PDPMV1 - [Bus Configuration 1]

mPraject View PROFIBUS Online Option Tools Windows Help

H&aEgk s
. ProzoftyGSD €4
(1] ProSoft
=% PROFIBUS DP -
g
EI{:l G ateway

D Schheider Electic GmbH
ED ProLing Cornm Gateways Inc.
Ei PraLine Profibus Slave
..... M Empty Slot

----- @ 1%ford Input

..... M 2words Input

..... M 2words Input

----- M 4words Input

----- M 5words Input

----- M &words Input

----- M 7words Input

----- M &words Input

----- M 9words Input

----- M 10%words Input

(3] ProLires

----- @ 11 wards Input A I

----- M 12words Input
----- M 13words Input

Slave:

[3] FraLing Profibus Slave Drevwvi

----- @ 14 wards Input Slot

| CFG data | ord

----- M 15words Input

----- M 1 word Output
----- M 2words Dutput
----- M Fwords Output

LIRE S R o)

----- 8 [ — = (T = =

For the example, I selected 100 input words and 100 outputs words (6 x 16W + 4W = 100W).

Slave: [3) ProLing Profibus Slave Device path:  PROFIBUS DPYGatevsaysProLing Cormm G ateways Inc. WProLing Prafibus 5.
Slot | CFG data | Order hurmberd designation | |hput address | Output address |
0 0=5F 16 Words Input 0.3
1 0=5F 16 Words Input 32..63
2 0=5F 16 Words Input £4...95
3 0=5F 16 Words Input 96,127
4 0=5F 16 Words Input 128..159
5 Ox5F 16 Words Input 160..191
B 0x53 4 Wards Input 192..199
7 OxEF 16 Words Output 0.3
g OxEF 16 Words Output 32..63
9 OxEF 16 Words Output B4...95
10 OxEF 16 Words Output 96,127
11 OxEF 16 Words Output 128.159
12 OxEF 16 Words Output 160...191
13 OxE3 4 Wwords Output 192..1599
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Close the ProSoft Configuration Builder for PROFIBUS using the menu Project>Exit:

i{ Pro5oft Configuration Builder for PROFIBUS - MVI

m Project View PROFIBUS Online Option Tools Wi

E Close
——  Save Cirl+5
- Opennew device catalog path... [1)Fn

Print... Ctrl+P W
Print preview...

Save the configuration as requested:

Prosoft Configuration Builder for x|

3 1 Close project: MYVIS&-PDPMY 1. xml
' Save project changes?

Yes Mo | Cancel |

Go back to the main window by clicking the OK button:
x

— PROFIBUS Master - Module Communications———————————
|Prufib!.|5 Editor : Terminated : Project Changed : Project

Select Port: ICorn 1 'I

Firmware Update |

TestCDnnectiDnl GIP. Path Edit | Cancel Update |

— PROFIBUS Setup and Monitor
[ Prohibit Master Control

Checksums

PROFIBUS: I F1434774
Configure PROFIBUS I Module: ISF?4FCED

Cancel Mantor/MMadify | Calculate |

— Processor Network Memory Map

Show Memory Map |

Export Master Config
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A.2.3. Download the configuration to the module

Right click on the MVI56-PDPMV1 module in the tree view and select:

Download from PC to Device
fﬂ Untitled - ProSoft Configuration Builder
File Edit View Project Tools Help

EI{:l Default Project I MName
= Default Location  MVISE
SR 1156 POPMU L] MVIS
Delete Cor
Rename EDP
Copy
LB
& MV Paste PRC
.12 proOFTI
Choose Module Type
Canfigure ast Cl
Yerify ast D
View Configuration
Write to Compact Flash
Export Configuration Filels
- - & flodu
Load Config File
add External File LasT
Download frem PC to Device
Upload from Device to PC 5 R
Diagnostics oad
2 AC
| # conf

In the window that appeared, select 1756-ENBT:

Download files from PC to module x|

STEP 1: Select Port |Com 1 =l |

Com 1
WUse Defa ZIF Bath Edit | Test Connection |

STEP 2: Transfer Files

DOWNLOAD | fbort | Cancel | 614 |

Click on CIP Path Edit:
x|

STEP 1: Select Port 1?55-ENBT vl |t=192-158-0-100,|:+=1,5:0

Use Default IP Address [T CIP Path Edit Test Connection

STEP 2: Transfer Files

DOWNLOAD Abort | Cancel | 61,4 |
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In the CIPconnect™ Path Editor, enter the correct parameters to address the MVI56-PDPMV1
module in the ControlLogix rack.

Click on Construct CIP Path:

¢

I‘r Connect” PATH EDITOR

Destination Module
Slot Number

Source Module Node

P | Destination Module

Source Module IP
No | Source Module Kidees
1756-ENBT 192.168.170.195

MVIS6-Module =l

t:152.168.170.195,p:1.5:1

Add Rack | Delete Rack I Construct CIP Path I

oK | Cancel |

You should see the module address path in the CIP path bar.

Click OK to go back to the download files from PC to module window:

[/

=

I‘r Connect” PATH EDITOR

Destination Module
Slot Number

Source Module Node
Address

| Destination Module

Source Module IP
No | Source Module Kidees
1756-ENBT 192.168.170.195

MVIS6-Module =l

t:152.168.170.195,p:1.5:1

Add Rack | Delete Rack | Construct CIP Path |
I oK I Cancel |
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Click DOWNLOAD to actually download configuration to the MVI56-PDPMV1 module.
Download files from PC to module x|

STEP 1: Select Port

1756-ENBT j It:192.158.1?0.195,D:1,5:1

Use Default IP Address [T CIP Path Edit | Test Connection |

STEP 2: Transfer Files

DOWNLOAD

The following states appear successively; click OK when the module running:

Download files from PC to module x|

lSending Config File

I Download files from PC to medule

ISending File : POPMV1.ddb

I Download files from PC to module

ISending File : PDPMV1.zip

I Download files from PC to module

abort |

STEP 1

STEP 1
STEP 2

STEP 1
STEP 2

STEP 2

|: STEP 1: Select Port 1?55-ENE‘-T 'I It:192-153-1?0-195p911p5:1
STEP 2

IRebDuting Module

I- Download files from PC to medule

lr"'ludule Running

.|

STEP 1

Use Default IP Address [ CIP Path Edit | Test Connection |

L

STEP 2: Transfer Files

L0 T L I

abort | Cancel oK

The configuration of the module using ProSoft configuration Builder is now finished.

You can save your project and close ProSoft configuration Builder.
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A.3. Step 3: Verifying communication

A.3.1. On PROFIBUS using the ProSoft Configuration Builder

Open your project in ProSoft Configuration Builder and double click on PROFIBUS DP:
(] MVI56-PDPMV1.ppf - ProSoft Conf

File Edit View Project Tools Help

-3 Default Project
EHEl Default Location
= MVISE-PDPMV1
[ g%, Comment
], MVI PDPM-V1

SRS} PR OFIELS DP

In the windows that appeared, click on Configure PROFIBUS:

PDPMV1 PROFIBUS Master Setup X

—PROFIBUS Master - Module Communications
IF"rcl-fihus Editor : Not started

Select Port: [1756-ENBT 7|
Firmware Update

| t:192.168.170.195,p:1,5:1
Cancel Update

Test Connection | CIF Path Edit |

—PROFIBUS Setup and Monitor
P Checksums

[T Prohibit Master Control
PROFIBUS: I
Configure PROFIBUS Module: I
Cancel MontarMadify | Calculate |

—Processor Network Memory Map

Show Memory Map |

Export Master Config
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Select the menu Online>Monitor/Modify:
f ProSoft Configuration Builder for PROFIBUS - MVIS6-PDPMV1
Project View PROFIBUS | Online Option Tools Windows Help

= | & (4 | —:i Download configuration
Monitor [ Modify = =
. ProzoftyGSD s Configuration 1
& % PROFIBUS DP Sek slave address, .,

i PROFIBUS M azter Cinlime prgpertiesln roSoft
(3] ProLire

Wait for few seconds to allow the connection to establish.

Once established, you should see a bar graph going right and left, the PROFIBUS slaves
should have a coloured border (see screenshot below):

7%’ Bus Configuration 1 -0 =|

Master |

(3] ProLins

Buz addr... | Type | I arne | Yendor | Cormrnemt -

D —

1 M azter ProSoft ProSoft Technology

2

3 Slave ProLin Profibus Slave ProLing Cornm G ateways. ..

4

a]

B

7 -

1| | 3
ANNNNRNEREN

Red means the communication is in error.
Green means communication is running.
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Double click on the slave you want to monitor and check the values in inputs and outputs:

¢ Online slave properties - (3) ProLinx Profibus Slave x|

Iodules I Tags | Diagnostic I
rInput

Module name |Address | Farmat |Value ‘ Statug | ﬂ

16 Words Input 0.3 Hex Fault

16 Words Input 3263 Hex Fault

16 Words Input 64..595 Hex Fault

16 Words Input 96.127 Hex Fault

16 Words Input 128..159 Hex Fault

16 Words Input 160..7191 Hex Fault

4'wWords Input 192..199 Hex Fault

]

 Output

Module name |Address | Farmat |Value ‘ Statug ﬂ

16 Words Dutput 0.3 Hex Fault

16 Words Dutput 3263 Hex Fault

16 Words Dutput B4..95 Hex Fault

16 Words Dutput 96..127 Hex Fault

16 Words Dutput 128..159 Hex Fault

16 Words Dutput 160..191 Hex Fault

4'words Output 192..199 Hex Fault

]

0K | nn Help |

In the screenshot below, the ProLinx PROFIBUS slave module was actually connected to the

MVI56-PDPMV1 module and communication was working fine:
x|

Modu\es“jl Tags | Diagnostic I

rInput
Module name |Address | Farmat |Va|ue ‘ Statug ﬂ
16 Words Input 0.3 Hex 000;0:=00;0400;0400:0:00 OF,
16 Words Input 32.63 Hex Ox00;0=00;0400;0:00:0:00 OF,
16 Words Input £4..95 Hex Ox00;0=00;0400;0:00:0:00 OF,
16 Words Input 96..127 Hex Ox00;0=00;0400;0:00:0:00 OF,
16 Words Input 128..159 Hex 0x00;0:00;0400;0:00.0:00 OF,
16 Words Input 160,791 Hex 0x00;0x00;0x00;0:00.0:00 OF,
4'wards Input 192199 Hex 0x00:0x00:0x00:0:00.0:00 0F
]
 Output
Module name: |Address | Format |Value ‘ Status ﬂ
16 Words Output 0.3 Hex 08071 :0802:0503:0x04:0:05 | Of
16 Words Dutput 32.63 Hex Ox21:0x22:0423:0024.0:25 OF
16 Words Dutput B4...95 Hex Ox41:0x42:0443:0244 045 OF
16 Words Dutput 96..127 Hex Ox61:0x62:0x63:0:64.0:00 OF
16 Wwords Output 128..159 Hex 0x00:0x00:0x00:0:00.0:00 0F
16 Words Output 160191 Hex 0x00:0x00:0x00:0=00.0:00  0F
4'wards Dutput 192199 Hex 0x00:0x00:0x00:0=00.0:00  0F
]

0K | T Help |
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A.3.2. Starting MVI56-PDPMV1 communication

The MVI56-PDPMV1 checks that his configuration and the configuration in the ControlLogix
matches using CRC method, it then starts communication.

In order to check the CRC, the ladder logic has to copy the CRC values coming from the
MVI56-PDPMV1 module in Local:x:I.Data[204] to Local:x:I.Data[207] to the module in
Local:x:0.Data[204] to Local:x:0.Data[207].

Right click on Controller Tags then select Monitor Tags:
§% RSLogix 5000 - MVIS6PDPMV1 [1756-L61]

File Edit View Search Logic Communications Tools W

Bl=a| 8| 5Ee] Sl

Dffline . 7 RUN
Mo Forces b F S.ET
Mo Edits g; 10
Fedundancy Lz

(3 contraller Fau | Mew Tag...
3 Power-Up Hal
525 Tasks | Monitor Tags

||
gl
il L
=3 Contraller MVISEPDPMY 1 ‘
Chrl+w

By default, the CRC are not copied from the Inputs to the Outputs (see below):
[=1-t4WISEPDIP KW ooo FOPRW1_Module...
Decimal SINT[1536]
Decimal SIMT[1536]
FOPRY1_backpl...
FPDPRW1_Status
FDPY1_Commanc
FOPY1_bailbox
FOPRWI_CRC_S...

[+]-b4%15EPD PR Dutput
[+]-+%15EFDPMY 1. I nput
[+-M45EPDPMY1.EP
[+]-MYISEPD PRV, Status
E

£

{
{
{
{
{
H-byISEPD PR M ailboxCommand {.
H-bAWISEPD PR Mailbox [eun
{
{
4
{

[=]-t4|SEFPDPMY1.CRC

e e el el e et P P
s e e e e e e |
P I AR I R R

. - e I R
== o o= a s | | | = = = = (= [

= MYISEPDPMV1.CRC.In .. POPMV1_CRC
F+-MVISEPDPMY1.CRC.In ProfibusCRC -24724903 Degimal DINT
[+ MVISEPDPMY1,CRC. InModuleCRC 20528846 Decimel DINT
=-MVISEFDPHMY1.CRC.Out {-..] POPMY1_CRC
[+]-1| BEFDPY 1. CRC. Out. ProfibusCRC Decimal DINT
F+-MVISEPDIPRY . CRC.Out ModulsCRC Decimal DINT
[+]-#VIS6PD PV MailboxCantrol {--. {-..1 POPMV1_MECan...
[+-MVISEPD P Lt {--- {-.-1 POPMYI_L
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Navigate to MVI56PDPMV1.MailboxCommand.SynchCRC and set a value of “1”.

[=I-t4WISEPDIPRY [...] [...] POPMY1_Module...
[+-MWISEFD PR O utput {...} {...}|Decimal SINT[1536]
[+-MWISEFD PR I nput {...} {...}|Decimal SINT[1536]
[+-MWISEFD PR BP {...} {...} POPMY1_backpl...
[+-MWISEFD PR Status {...} {...} POPMY1_Status
[=|-b4%ISEFD P M ailboxCormmand [...1 [...1 FPDPRY1_Commanc

—tdW/ISEPLIPkY M allboxCommand. Stopkd ode [u} Decimal BOOL
—tdWISEPDIPRY1 M ailboxCommand O peratetd ode [u} Decimal BOOL
—HWISEPDPR. M ailboxCommand. Cleatd ode a Decimal BOOL
—tdWISEPLIPKY M ailboxCommand. SynchCRC 1 Decimal BOOL
—tWISEPDPR .M ailboxCommand. Getlivelist a Decimal BOOL
— AW ISEPD PR M ailboxCommand GetSlaveConfig [u} Decimal BOOL

Note: In the current implementation of the Add-On Instruction, you will have to

manually reset the value to “0".

You can see now that the CRC values match from Inputs to Outputs:

Date: Feb-09

(=M ISEPDIP Y [...1 [...1 POPMY1_Module...
[+H-tYISERD PR D utput [...] [...}|Decimal SINT[153E]
[+H-MYISEPD PRV I nput focal {usa}|Decimal SINT[1536]
[+-MvISEFDPMY1.BF Hocal Hocol POPKY1_backpl...
[+]-MVISERPD P Status {-..1 [..-1 POPMY1_Status
[+]-MVISERD P M ailboxCornmand {-..1 [..-1 POPMY1_Commanc
[ MI5EPD PMVA Mailbox {1 [-.-1 POPMYI_Maibox
[=-t4%ISEFD PR CRC [...1 [...1 POPMYI_CRC_S..

E-M\-"IEBPDPMW.CHC.In [...1 [...1 POPMY1_CRC
[F]-MISEPDPMY 1. CRC.In. ProfibusCRC -247249038 Decimal DINT
[+H-MYISEPDPMY 1, CRC. In.MaduleCRC 205288467 Decimal DINT
[=-MYISEPDPMY1.CRC. Dut Hocal Hocol PDPMY1_CRC
[]-MISEPDIPMY 1. CRC. Out. PrafibusCRC —247249038 Decimal DIMT
[+]-MYISEPDPMY . CRC.Out ModuleCRC 205288467 Decimal DINT
- MYISERD Py MailboxCortrol [-..1 [-..1 POPM1_MECan..
[+H-b4vISEPD PrAw 1 LI [...1 [...1 POPR W1 _LIE
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B. APPENDIX

B.1. Appendix A - Importing GSD files

In the ProSoft Configuration Builder for PROFIBUS tool, select the following menu:
Tools>Install new GS*-file...

;"5' ProSoft Configuration Builder for PROFIBUS - MVIS6-PDPMV1 - [Bus Con
Ed Project view PROFIBUS Online Option | Tools Windows Help

Install new G5=-file...
AProgofthGSD €«

1] PraSoft
=-5% FROFIBUS DF

- PROFIBUS Master Master |

[3] ProLins

Browse your computer to the directory where you placed your products’ GS* files then
click Open:

x|
G\\_)v [ - PROFIBUSDP - GED - ETZ00M -TM1S31 = [ [5m o (2]

Organize ~ 3 Views ~ I Mew Folder (7]

GSD viewer...

Favorite Links e e e ad

FE Documents
5l RecentPlaces
Bl Desktop

Maore

Folders

<

| CPU416-3_v4 =
CPU417-4

| CPU417-4_v4

| EM277

. ET200M - IM153-1

| ET200M - IM153-2

| IM308-C

| PPX505-6870
55-95U
cmanTion 27 =

File name: [siem801d gsd 7| |eDries (g =l

The following message will appear, select Yes or No depending on your needs:
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:] Are there any pictures for GS*-file?
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If you selected Yes, select the corresponding picture in the next window:

~f Select bitmap file / files for installation x|

C}\:) [ - PROFIBUSDP - GED - ETZ00M -TM1531 = [ [5m o (2]

Organize ~ 3 Views ~ I Mew Folder (7]

Mame = || Date modified | ~| Type

Favorite Links
FE Documents
5l RecentPlaces
Bl Desktop

Maore

Folders A
| CPU416-2 =
CPU416-2 V4
| CPU416-2PCT
| CPU416-3
| CPU416-3 V4
| CPU417-4
| CPU417-4 V4 =
| EM277
ET200M - [M153-1
Fronou - T 1ean =
File name: [im153_1n bmp x| [Bimaps "bmp) =l

I Cpen Cancel |

If multiple images are available, repeat the operation as required.

The GS* file has been imported in the ProSoft Configuration Builder for PCB.
It is available in the PROFIBUS slaves list as below:

mPraject View PROFIBUS Online
H sl S5

_WProzafthG50

EI--«'I-IE PROFIBUS DF
=R g
l:l Telemecanique
=3 SIEMENS
Lj ET 200k [IM153-1]
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B.2. Appendix B - Changing PROFIBUS slave address

By default, the ProSoft Configuration Builder for PROFIBUS defines node slave address.
You can change it to agree with your application as described below.

In the ProSoft Configuration builder for PROFIBUS, double click on the slave you want to
change the node address to:

;"5' ProSoft Configuration Builder for PROFIBUS - MVIS6-PDPMV1 - [Bus Configuration 1]
m Project View PROFIBUS Online Option Tools Windows Help

B 2k aos

AProgofthGSD €«
(1] ProSoft
=% PROFIBLUS DP

=0 140
- -0 Telemecaniue

-3 SIEMENS
(3] ProLins

L] ET 200M (M1534)
E-0 Gateway

D Dinives ‘
-0 Contraller
M- General ProLinx Profibus Slave

- i PROFIBUS Mazter

Select the node address you planned to use for this particular slave in PROFIBUS address
then click OK:

2’ Slave properties - ProLinx Profibus Slave ﬂ

| Pararneter aszignment |

G5 file: powallbab.ged

PROFIEUS address: I

Wendar: ProLire Comm Gatewa...
. ’ 4
Family path: Gateway

r kodule

aclivate Slave v
Model name: ProLing Profibug Slave wWatchdog v
Slave name: PraLine Profibus Slave M aximum baud rate: 12000 kBit/sec
Sync / freeze property
[¥ SYMC
[ FREEZE Group assighment |
Caommet:

Cancel | Help |

The slave’s node address as been changed.
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You have to download the configuration to the module.

Author: Jerome Prat Page 39 of 44
Date: Feb-09 TN2009-01D-A4-2.0



Technical Note

0:2:0 )
PrOSOﬂ How to Setup MVI56-PDPMV1
M

TECHNOLOG Y Using Add-On Instruction and CIPconnect'

B.3. Appendix C — Configuring RSLinx

Start RSLinx Classic from the start menu

Start>All programs>Rockwell Software>RSLinx>RSLinx Classic
, Rodkwell Software

, BOOTP-DHCP Server
, FactoryTalk Activation
. FactoryTalk Tools

. R5Linx

"Q\ RSLinx Classic
% RSLinx Classic Backup Restore Utilit™
% R5Linx Classic Launch Control Panel
@ RSLinx Classic Online Reference

| Tools

. R5Logix 5 English -

1 Back

n
il
i
1]
il
EEI

Select the menu Communication>Configure Drivers...:
*':E‘- RSLinx Classic Professional

File Edit View | Communications Station DDE/OPC  Security Window Help
ERE
Configure Drivers...
Configure Shortouts. ..
Choose the needed driver in the Available Driver Types list (to connect to the CPU using
Ethernet, EtherNet/IP Driver is a good choice) then click on Add New...:
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Configure Drivers

—&vailable Driver Types;

[

1784-U2DHP for DH+ devices

R5-232 DF1 devices

— [ Ethermet devices

Ethertet/IP Diriver

DF1 Polling taster Dnver
1784-PCICIS] for ContralMet devices
DF1 Slave Driver

DH485 UIC devices

irtual Backplane [SoftLogi=58ss, 1SE)
DeviceMet Dirivers [1770-KFD SDMPT drivers)
SmartGuard USE Driver

Femate Devices via Link Gateway

\_I:
Ix

Cloge
Add Mew. ..
Help

| Status |

Configure...
Startup...
Start

Stop

s

[elete
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Choose a name for the driver (the default one is correct one):

Add New RSLinx Classic Driver

Choose a name for the new driver.
[15 characters masimum]

|£B_ETHIP-1 —ll:ame'

x|

Select the way you want to connect to the CPU then click OK:

Configure driver: AB_ETHIP-1 2 x]

Etherhet/IP Settings |

' Browse Local Subnet

" Erowse Remate Subnet

Description

| IP Address |

Windows Default
Intel(R) WiFi Link 5100 AGN

Broadcom Met¥treme 5o Gigabit Controller

o= |

unknown
1592.168.170.16

The driver is now installed and running, click close to go back to RSLinx Classic:

—&vailable Driver Types;
| EtherNet/IP Driver | addNew |
Help
— Configured Drivers:
Mame and Description | Status |
AB ETHIP-T AR Ethernet BUMNING Configure...

Startup...
Start
Stop

[elete

ddili
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Exit RSLinx and go back to RSLogix, your driver would be available and you should be able to
connect to the CPU.
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Technical Note

For further information feel free to contact ProSoft Technology Technical Support at
one of the following addresses:

Europe & Africa: ProSoft Technology

Middle East:

North America:

Latin America:

Asia & Pacific:

Blagnhac (Toulouse), France

+33 (0)5.3436.8720 Phone

+33 (0)5.6178.4052 Fax
support.emea@prosoft-technology.com

ProSoft Technology

Dubai, United Arab Emirates

+971 (0)4.214.6911 Phone

+971 (0)4.214.6912 Fax
fmohammed@prosoft-technology.com

ProSoft Technology
Bakersfield, California USA

+1 (661) 716.5100 Phone

+1 (661) 716.5110 Fax
support@prosoft-technology.com

ProSoft Technology

The Woodlands (Houston), Texas USA
+1 (281) 298.9109 Phone

+1 (281) 298.9336 Fax
latinam@prosoft-technology.com

ProSoft Technology

Salangor (Kuala Lumpur), Malaysia
+603 7724.2080 Phone

+603 7724.2090 Fax
asiapc@prosoft-technology.com
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